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ABSTRAKT 

 

Diplomová práce je zaměřena na popis možností modifikace systému ECCAIRS 

pomocí sady nástrojů Taxonomy Design Tools a vytvoření návrhu využití této sady 

pro zjednodušení práce se systémem ECCAIRS na národní úrovni. Teoretická část 

zahrnuje popis legislativy vztahující se k hlášení leteckých nehod a incidentů, tedy 

Nařízení Evropského parlamentu a Rady (EU) č. 376/2014, dále je uveden postup 

hlášení leteckých událostí v České republice a popis samotného systému ECCAIRS, 

jeho nástrojů, funkcí a možností modifikace. Praktickou část práce tvoří vlastní návrh 

využití zmíněné sady nástrojů pro zefektivnění práce se systémem ECCAIRS, včetně 

podobného popisu postupu provedení. 

 

 

ABSTRACT 

 

The diploma thesis focuses on describing the potential modifications of the ECCAIRS 

system, using the Taxonomy Design Tools toolkit, and creating a proposal to use 

the toolkit to simplify the user experience of the ECCAIRS system on a national level. 

The theoretical part includes a description of the legislation related to the aviation 

accidents and incidents reporting, covered by the Regulation (EU) No 376/2014, 

followed by the procedure of aviation occurrence reporting in the Czech Republic 

and the description of the ECCAIRS system, its tools, features and modification 

options. The practical part of the thesis contains the proposal of using the specified 

toolkit to optimize the ECCAIRS system usage efficiency, including a detailed 

description of the steps taken to achieve that goal. 
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ÚVOD 

 

S rozvojem techniky, cestovního ruchu, obchodu a celkově s uspěchaností doby se 

zvyšuje poptávka po leteckém provozu jakožto nejrychlejší možné přepravě do stále 

více lokalit. Tento trend s sebou bohužel přináší vyšší riziko nehod a incidentů. 

Pro zachování standardu bezpečnosti v civilním letectví je nutné dělat maximum. 

Na základě studie se v Evropské unii (EU) zrodila myšlenka vzniku jednotného 

evropského databázového systému hlášení leteckých nehod a incidentů, kde budou 

všechny informace ukládány, sdíleny a analyzovány. Vyhodnocení těchto analýz by 

mělo vést k odhalení případných hrozeb a následnému přijetí potřebných opatření 

k jejich nápravě. Evropská komise proto pověřila středisko JRC (Joint Research 

Centre of the European Commission) vytvořením systému ECCAIRS (European Co-

ordination Centre for Aviation Incident Reporting System), sdíleného databázového 

systému, který byl zaveden pro členské státy EU a později se rozšířil 

i do mimoevropských států. 

 

 Cílem této diplomové práce je definovat možnosti modifikací systému ECCAIRS 

pomocí sady nástrojů ECCAIRS 5 Taxonomy Design Tools, včetně návrhu konkrétní 

modifikace pro zefektivnění práce s tímto systémem na národní úrovni. 

 

 Teoretická část práce je věnována hlášení leteckých nehod a incidentů, legislativě, 

která se k němu vztahuje, konkrétně Nařízení Evropského parlamentu a Komise (EU) 

č. 376/2014, a také popisu hlášení leteckých událostí v České republice. Dále je 

popsán systém ECCAIRS, historie jeho vzniku a vývoje a jsou rozebrány základní 

nástroje a aplikace tohoto systému. Následuje část zabývající se možnostmi 

modifikací systému ECCAIRS, a to nejen pomocí sady Taxonomy Design Tools, ale 

i sady nástrojů User Interface Design. Je zde obsažen detailní popis funkcí 

jednotlivých nástrojů obou sad. 

 

 Praktickou část představuje samotný návrh využití sady Taxonomy Design Tools 

pro zlepšení práce se systémem ECCAIRS na národní úrovni, tedy rozšíření nabídky 

zobrazení informací (náhledů) pro ECCAIRS Browser (Prohlížeč) o nové, které 

obsahuje strukturu položek odpovídající používaným formulářům hlášení událostí, 

včetně národní mutace příslušné části taxonomie. V práci je uveden popis návrhu a 

postup provedení společně s blokovým schématem posloupnosti kroků v rámci 

jednotlivých použitých nástrojů. Soubory přeložené taxonomie a nového náhledu jsou 

součástí elektronické přílohy této práce. 
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1   LETECKÉ NEHODY A INCIDENTY 
 

1.1   Definice 

 

K definici používaných pojmů poslouží předpis L13 o odborném zjišťování příčin 

leteckých nehod a incidentů, kde je Hlava 1 věnována právě definicím. 

 

INCIDENT (INCIDENT) 

Událost jiná než letecká nehoda, spojená s provozem letadla, která ovlivňuje nebo by 

mohla ovlivnit bezpečnost provozu. 

 Jedná se o chybnou činnost osob nebo nesprávnou činnost leteckých 

a pozemních zařízení v leteckém provozu, jeho řízení a zabezpečování, jejíž 

důsledky však zpravidla nevyžadují předčasné ukončení letu nebo provádění 

nestandardních (nouzových) postupů. 

 Incidenty v letovém provozu se rozdělují podle příčin na: 

a) letové‚ 

b) technické‚ 

c) v řízení letového provozu, 

d) v zabezpečovací technice, 

e) jiné. 

 Mezi příčiny incidentů se zahrnují i nepředvídatelné přírodní jevy (výboje statické 

elektřiny, střety s ptáky apod.), pokud neohrozily bezpečnost letu do té míry, že byly 

hodnoceny jako vážný incident nebo letecká nehoda. 

 

LETECKÁ NEHODA (ACCIDENT) 

Událost spojená s provozem letadla, která se, v případě pilotovaného letadla, stala 

mezi dobou, kdy jakákoliv osoba nastoupila do letadla s úmyslem vykonat let 

a dobou, kdy všechny takové osoby letadlo opustily, nebo která se, v případě 

bezpilotního letadla, stala mezi dobou, kdy letadlo je připraveno k pohybu pro účely 

letu a dobou, kdy zastaví na konci tohoto letu a hlavní pohonná soustava je vypnuta, 

a při které: 

 a) některá osoba byla smrtelně nebo těžce zraněna následkem: 

  - přítomnosti v letadle, nebo 

  - přímého kontaktu s kteroukoli částí letadla, včetně částí, které se od 

     letadla oddělily, nebo 

  - přímým působením proudu plynů (vytvořených letadlem), 

      

s výjimkou případů, kdy ke zranění došlo přirozeným způsobem, nebo 

způsobila-li si je osoba sama nebo bylo způsobeno druhou osobou, nebo 

jestliže šlo o černého pasažéra ukrývajícího se mimo prostory normálně 

používané pro cestující a posádku; nebo 
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 b) letadlo bylo zničeno, nebo poškozeno tak, že poškození: 

  - nepříznivě ovlivnilo pevnost konstrukce, výkon nebo letové 

     charakteristiky letadla, a 

  - vyžádá si větší opravu nebo výměnu postižených částí, 

s výjimkou poruchy nebo poškození motoru, jestliže toto poškození je omezeno 

pouze na jeden motor (včetně jeho příslušenství nebo motorových krytů); vrtulí 

(rotorových listů), okrajových částí křídel, antén, snímačů, lopatek, pneumatik, 

brzd, podvozku, aerodynamických krytů, palubní desky, krytů přistávacího 

zařízení, čelních skel, potahu letadla (jako jsou malé vrypy nebo proražení) 

nebo nevýznamná poškození listů hlavního rotoru, listů ocasního rotoru, 

přistávacího zařízení a těch poškození, která jsou zapříčiněna krupobitím nebo 

střetem s ptákem (včetně poškození krytu radarové antény na letadle); nebo 

 c) letadlo je nezvěstné‚ nebo je na zcela nepřístupném místě. 

 

VÁŽNÝ INCIDENT (SERIOUS INCIDENT) 

Incident, jehož okolnosti naznačují vysokou pravděpodobnost letecké nehody, jenž je 

spojený s provozem letadla a který se, v případě pilotovaného letadla, stal mezi 

dobou, kdy jakákoliv osoba nastoupila do letadla s úmyslem vykonat let a dobou, kdy 

všechny takové osoby letadlo opustily, nebo který se, v případě bezpilotního letadla, 

stal mezi dobou, kdy letadlo je připraveno k pohybu pro účely letu a dobou, kdy 

zastaví na konci tohoto letu a hlavní pohonná soustava je vypnuta. 

 

ODBORNÉ ZJIŠŤOVÁNÍ PŘÍČIN (INVESTIGATION) 

Proces, prováděný za účelem prevence leteckých nehod a incidentů, který zahrnuje 

shromáždění a analýzu všech potřebných informací, vypracování závěrů včetně 

určení příčin a/nebo faktorů, které k nim přispěly, a v případě potřeby zpracování 

bezpečnostních doporučení. [6] 

 

1.2   Nařízení Evropského parlamentu a Rady (EU) č. 376/2014 

 

Hlášením událostí v civilním letectví, analýzou těchto hlášení a navazujícími 

opatřeními se zabývá Nařízení Evropského parlamentu a Rady (EU) č. 376/2014 

ze dne 3. dubna 2014. Cílem tohoto nařízení je zavést proaktivnější a empiricky 

důkladněji podložené bezpečnostní mechanismy zaměřené na předcházení vzniku 

nehod na základě analýzy všech relevantních bezpečnostních informací včetně 

informací o událostech v civilním letectví. 

 

 Tímto nařízením se stanoví pravidla pro: 

- Hlášení událostí, které ohrožují nebo které, pokud by nebyly napraveny 

nebo řešeny, by ohrozily letadlo, osoby na palubě, jakékoli další osoby, 

vybavení či instalaci s dopadem na provoz letadla, a poskytování 

příslušných informací souvisejících s bezpečností, 
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- Analyzování a navazující opatření ve vztahu k ohlášené události 

a informacím týkajícím se bezpečnosti, 

- Ochranu pracovníků v letectví, 

- Odpovídající využití shromážděných informací týkajících se bezpečnosti 

- Začlenění informací shromážděných do evropské centrální evidence, 

- Šíření anonymizovaných informací mezi zúčastněnými osobami, aby tak 

tyto osoby měly k dispozici informace, které potřebují ke zvýšení 

bezpečnosti letectví. 

 

 Nařízení se vztahuje na události a jiné informace související s bezpečností 

civilních letadel, s výjimkou letadel uvedených v příloze II nařízení č. 216/2008. 

Členské státy mohou rozhodnout o tom, že se nařízení č.376/2014 bude rovněž 

vztahovat na události a jiné informace související s bezpečností letadel uvedených 

v příloze II nařízení č. 216/2008. 

 

 Evropský parlament a Rada přijaly toto nařízení z mnoha důvodů – v Unii by měla 

být zajištěna všeobecně vysoká úroveň bezpečnosti civilního letectví a mělo by být 

vyvinuto veškeré úsilí ke snížení počtu nehod a incidentů s cílem zajistit důvěru 

veřejnosti v leteckou dopravu. Počet smrtelných nehod v civilním letectví zůstává 

v posledním desetiletí prakticky nezměněn, nicméně existují obavy, že se v příštích 

desetiletích počty nehod zvýší v důsledku nárůstu objemu letecké dopravy a zvyšující 

se technické složitosti letadel. Z dosavadních zkušeností vyplývá, že v mnoha 

případech již před samotnou nehodou poukazuje na existenci bezpečnostních 

hrozeb řada událostí a jiných nedostatků. Bezpečnostní informace tak představují 

důležitý zdroj pro odhalování aktuálních nebo potenciálních bezpečnostních hrozeb. 

[8] 

 

1.2.1   Osoby nahlašující události 

 

Hlášení leteckých událostí provádí podle nařízení tyto osoby: 

 

a) Velící pilot nebo kterýkoli další člen posádky v linii vedení letadla, pokud velící 

pilot není schopen podat hlášení, nebo provozovatel letadla 

b) Osoba podílející se na konstrukci, výrobě, udržování letové způsobilosti, 

sledování údržby či úpravě letadla, kteréhokoli zařízení nebo jeho části 

c) Osoba, která podepisuje osvědčení kontroly letové způsobilosti nebo ověření 

o uvolnění do provozu týkající se letadla, zařízení nebo jeho části 

d) Pracovník poskytovatele služeb letového provozu, jemuž je svěřena 

odpovědnost týkající se letových navigačních služeb, nebo pracovník letové 

informační služby 

e) Osoba zastávající funkci týkající se zajištění bezpečnosti letiště 
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f) Osoba zastávající funkci spojenou s instalací, pozměňováním, údržbou, 

opravou, renovací, letovou zkouškou nebo kontrolou leteckých navigačních 

zařízení 

g) Osoba zastávající funkci spojenou s odbavováním letadel, včetně tankování, 

sestavení nákladového listu, nakládky a vykládky, odmrazování a vlečení 

na letišti [8] 

 

1.2.2   Povinné a dobrovolné hlášení událostí 

 

 Nařízení č.376/2014 rozděluje hlášení událostí na povinné a dobrovolné. Seznam 

klasifikovaných událostí v civilním letectví, které podléhají povinnému hlášení podle 

nařízení Evropského parlamentu a Rady (EU) č.376/2014, stanoví Prováděcí 

nařízení Komise (EU) 2015/1018. Toto nařízení stanovuje podrobnou klasifikaci 

událostí v rámci povinných systémů podávání zpráv podle čl. 4 odst. 1 nařízení (EU) 

č. 376/2014. Klasifikace je uvedena v přílohách I až V tohoto nařízení (viz příloha 1). 

 

 Při vkládání informací do příslušných databází o každé povinně hlášené události 

a v co největší míře o každé dobrovolně hlášené události zajistí organizace, členské 

státy a agentura EASA (European Aviation Safety Agency, v překladu Evropská 

agentura pro bezpečnost letectví), aby hlášení o událostech v těchto databázích 

obsahovala alespoň základní informace, které jsou uvedeny v příloze 2 této práce.[8] 

 

1.3   Hlášení leteckých nehod a incidentů v ČR 

 

Hlášení leteckých nehod a incidentů v České republice jakožto členském státu 

Evropské unie též podléhá Nařízení Evropského parlamentu a Rady č.376/2014. 

Odpovědným orgánem pro shromažďování, ukládání a vyhodnocování dat 

o leteckých nehodách na národní úrovni je v ČR Ústav pro odborné zjišťování příčin 

leteckých nehod (ÚZPLN). 

 

1.3.1   Ústav pro odborné zjišťování příčin leteckých nehod 

 

Ústav pro odborné zjišťování leteckých nehod se zabývá odborným zjišťováním 

příčin leteckých nehod, ale také podle nařízení č. 376/2014 shromažďováním, 

ukládáním a vyhodnocováním dat o leteckých nehodách na národní úrovni a jejich 

následným pravidelným odesíláním do centrální databáze. 

  

 ÚZPLN byl zřízen dne 1. ledna 2003, je správním úřadem se sídlem v Praze. Jeho 

činnost je rozdělena do tří oddělení: Oddělení letových inspektorů, Oddělení 

technických inspektorů a Oddělení správy, rozvoje a analýz. [7] 
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1.3.2   Proces hlášení letecké události v ČR 

 

Osoba nahlašující událost má na výběr ze dvou možností hlášení letecké události: 

a) Hlášení přes portál ÚZPLN 

b) Hlášení přes portál Aviation Safety Reporting (Hlášení letecké bezpečnosti) 

 V každém případě toto hlášení v jistém bodě procesu zpracovává ÚZPLN. 

 

  Pro hlášení události, stejně jako úpravu podaného hlášení, prováděné přes portál 

ÚZPLN je možno použít tlačítka: 

- Hlášení událostí dle nařízení č. 376/2014, nebo 

- Aviation Safety Reporting, které uživatele přesměruje na portál Aviation Safety 

Reporting. 

 Obě tyto možnosti se vztahují na všechny události související s bezpečností 

v civilním letectví kromě letadel uvedených v Příloze II nařízení (ES) č. 216/2018. 

Podle Průvodce hlášením událostí v civilním letectví ÚZPLN doporučuje použití ikony 

Aviation Safety Reporting, která umožňuje uživateli vytvořit nebo upravit formulář 

hlášení dle typu organizace a druhu hlášené události. [7] 

 

 Portál ÚZPLN poskytuje i formuláře pro: 

- Hlášení událostí pro anexovaná letadla, vztahující se na letadla uvedená 

v Příloze II nařízení (ES) č. 216/2018, a  

- Hlášení událostí para pro hlášení událostí v parašutistickém provozu, 

Tyto události však nespadají pod nařízení č. 376/2014. Podoba tlačítek je 

na obrázku 1.1. 

 
Obr. 1.1: Tlačítka výběru formuláře na portálu ÚZPLN 
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 Při výběru tlačítka Hlášení události dle nařízení č. 376/2014 má uživatel na výběr 

systém dobrovolného hlášení události, nebo systém povinného hlášení události, 

a pro oba tyto systémy je možnost zvolit si online vyplnění daného formuláře nebo si 

stáhnout offline verzi formuláře ve formátu XLS a vyplnit jej v programu MS Excel. 

Online a offline verze formulářů jsou vždy informačně shodné. Povinný i dobrovolný 

formulář je uveden v příloze 5 této práce. 

 

 Na portálu Aviation Safety Reporting musí uživatel provést volbu mezi hlášením 

na jeho osobní odpovědnost nebo na odpovědnost organizace, pod kterou patří. 

V obou případech následuje výběr státu, který uživateli vydal jeho licenci, případně 

kde má organizace své hlavní sídlo. Při hlášení na osobní odpovědnost je pak 

uživateli k dispozici jeden formulář v online nebo offline verzi která je ve formátu 

PDF. Při hlášení na odpovědnost organizace je dále na výběr mezi pěti různými 

formuláři podle typu organizace a druhu události, všechny opět v online i offline verzi. 

 

 Posloupnost hlášení letecké události v ČR je na obrázku 1.2. Osoba nahlašující 

událost použije formulář povinného hlášení, nebo dobrovolného hlášení. Vyplněný 

formulář dále pošle buď organizaci, pod kterou patří a která pak hlášení pošle 

na ÚZPLN, nebo přímo ÚZPLN. Odpovědní pracovníci ÚZPLN podané hlášení 

zpracují a vloží do národní databáze. Hlášení uložená v databázi si mohou 

pracovníci prohlédnout pomocí nástrojů systému ECCAIRS, které má ÚZPLN 

k dispozici. Vybraná hlášení událostí jsou pak automaticky stahována z národní 

databáze do Evropské centrální databáze, kterou spravuje středisko JRC. Středisko 

JRC může data prohlížet a analyzovat prostřednictvím vlastních nástrojů systému 

ECCAIRS. 

 
 

Obr. 1.2: Posloupnost hlášení letecké události 
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2   SYSTÉM ECCAIRS 

 

Databázový systém ECCAIRS je jedním z pasivních nástrojů, které jsou vyvíjeny 

ke zvýšení bezpečnosti letecké dopravy. Tento systém byl vytvořen pro hlášení 

leteckých nehod a incidentů v rámci členských států Evropské unie.  Slouží 

ke shromažďování, sdílení, ukládání a analyzování informací o mimořádných 

situacích v letectví, čímž slouží k prevenci leteckých nehod a incidentů. [3] 

 

 ECCAIRS je kooperační síť evropských úřadů pro civilní letectví (Civil Aviation 

Authorities (CAAs)) a úřadů pro vyšetřování leteckých nehod (Safety Investigation 

Authorities (SIAs)). Projekt je organizován střediskem JRC na žádost generálního 

představenstva pro mobilitu a dopravu (Directorate General for Mobility 

and Transport). JRC v rámci tohoto projektu úzce spolupracuje s agenturou EASA.[1] 

 

2.1   Historie systému ECCAIRS 

 

Evropská komise zahájila v roce 1989 studii v oblasti systémů hlášení incidentů. 

Na základě této studie bylo doporučeno založení Evropského koordinačního centra 

pro systémy povinného hlášení incidentů. V této souvislosti JRC provedlo studii 

realizovatelnosti integrace informací z různých již existujících nekompatibilních 

zdrojů. Dalším cílem bylo nabídnout společný systém hlášení nehod těm členským 

státům, které neměly automatizovaný systém hlášení. Projekt byl nazván ECCAIRS a 

byl představen v roce 1995 jako verze ECCAIRS 3. Evropská komise pak začala 

vyvíjet příslušnou legislativu, stejně jako potřebná technická řešení. V roce 2001 byla 

vytvořena verze ECCAIRS 4, která byla kompatibilní se systémem hlášení událostí 

ADREP (The Accident/Incident Data Reporting; v překladu Hlášení dat 

o nehodách/incidentech). Vývoj tohoto systému iniciovala Mezinárodní organizace 

pro civilní letectví ICAO (International Civil Aviation Organisation) v roce 1974 

za účelem monitorování leteckých nehod a jejich následnou analýzu. V roce 2003 

byla databáze ADREP převedena do ECCAIRS 4. Vývoj verze ECCAIRS 5 započal 

v roce 2007, přičemž JRC se rozhodlo přepracovat systém tak, aby byl lépe 

přizpůsobitelný uživatelem a aby byl použitelný pro více druhů dopravy – lodní 

a železniční, viz obrázek 1.2. Verze ECCAIRS 5 je plně funkční od roku 2011. [1] [2] 

 

 
Obr. 2.1:  Logo ECCAIRS [5] 
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2.2   Legislativa 

 

Systém ECCAIRS je přímo spojený se dvěma nařízeními Evropské unie: 

- Nařízení č. 996/2010 o vyšetřování a prevenci nehod a incidentů v civilním 

letectví, a 

- Nařízení č. 376/2014 o hlášení, analýze dalším vyšetřování událostí v civilním 

letectví. 

 ECCAIRS realizuje požadavky na shromažďování a šíření dat podle těchto 

nařízení v rámci zpráv o událostech i bezpečnostních doporučení.  

 

 Informace od členských států jsou integrovány ve dvou centrálních databázích: 

- Evropský centrální archiv událostí (ECR-ECCAIRS, The European Central 

Repositories for Occurences) – požadovaný nařízením č. 376/2014, a 

- Evropský centrální archiv pro bezpečnostní doporučení (ECR-SRIS, The 

European Central Repositories for Safety Recommendations) – požadovaný 

nařízením č. 996/2010. 

 Oba archivy jsou momentálně umístěny v JRC. Přístup do archivů podléhá 

striktním pravidlům a většinou je omezen na evropské kompetentní autority. [1] 

 

2.3   Uživatelé systému ECCAIRS 

 

Na obrázku 2.2 jsou znázorněny počty uživatelů a organizací využívajících systém 

ECCAIRS na jednotlivých kontinentech po celém světě. 

 

 

 
 

Obr. 2.2:  Uživatelé systému ECCAIRS [1] 

Situace ke 12. listopadu 2017 Počet uživatelů ECCAIRS na daném kontinentu 
Počet organizací využívajících ECCAIRS na daném kontinentu 
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 2.4   ECCAIRS Reporting System a další nástroje 

 

ECCAIRS Reporting System, neboli Systém hlášení, umožňuje evropským úřadům 

shromažďovat a vyměňovat si informace o dopravních nehodách a incidentech 

standardizovanou cestou. ECCAIRS Reporting System je sada softwarových 

aplikací, které společně vytváří kompletní systém pro organizace, které chtějí 

shromažďovat informace o dopravních událostech. K tomu, aby bylo možné rozlišit 

databáze pro různé druhy dopravy (leteckou, lodní a železniční), slouží nezávislá 

aplikace Taxonomy (Taxonomie). [4] 

 

2.4.1   Základní struktura systému ECCAIRS 

 

Occurrence 

Základním datovým záznamem v ECCAIRS Reporting System je Occurrence 

(Událost). Událost je jakýkoli druh nehody nebo incidentu v daném druhu dopravy. 

 Repositories (Úložiště) zajišťují přístup k ECCAIRS Reporting System s využitím 

specifických taxonomií, dokumentace, oprávnění a uzpůsobení dle vlastních potřeb. 

 Události jsou popsány pomocí sady vlastností (attributes), které jsou organizovány 

v tématech (topics) a souvisejících sekcích (section). 

 Stejná událost může být zobrazena pomocí různých náhledů (views). 

 

Attributes 

Data v ECCAIRS Reporting System jsou shromážděna ve stovkách různých atributů 

(vlastností). Hodnoty těchto atributů jsou uloženy v databázi stanovené úložištěm 

ECCAIRS, ke kterému je uživatel připojen. Podle typu atributu definovaného 

v taxonomii mohou být hodnoty tohoto atributu vkládány ručně nebo vybrány 

ze seznamu předem určených hodnot. 

 

Sections 

Pro lepší vizualizaci a úpravu jsou atributy seskupeny v sekcích (sections). Například 

atributy „Zeměpisná šířka“ a „Zeměpisná délka“ místa, kde se událost stala, jsou 

seskupeny v sekci „Kde“. 

 

Topics 

Z důvodu lepší navigace mohou být sekce rozděleny do témat (topics). Témata jsou 

hierarchicky zobrazena v Topic Tree (Strom témat), což může uživateli usnadnit 

hledání konkrétní informace o dané události.  
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Views 

Views (Náhledy) jsou různá seskupení témat v Topic Tree. Typy náhledů, které jsou 

uživateli k dispozici, závisí na úložišti, ke kterému je připojen, ale také na konkrétním 

nastavení uživatele a někdy i na podmínkách při vkládání dat události. 

 

Taxonomy 

Taxonomie (Taxonomy) ECCAIRS je katalog informací určující, které informace 

mohou být uloženy v ECCAIRS Repository a případně jak jsou tyto informace 

zakódovány v datových polích. Každá položka hlášení letecké nehody v ECCAIRS se 

nazývá Occurrence. Taxonomie Occurrence je složena z entities (entity) a k nim 

vztažených atributů. 

 

Entity reprezentují položky, ke kterým jsou přidruženy atributy. Entitou může být 

například „letadlo“, které souvisí s danou událostí, apod. Každá entita může mít 

libovolné množství subentit (child entity), pro představu entita „motor“ je subentitou 

entity „letadlo“. Atributy pak popisují vlastnosti nebo hodnoty, které jsou spojované 

s danou entitou, pod kterou patří. [4] 

 

 
 

Obr. 2.3: Ukázka struktury taxonomie 
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 Ukázka struktury taxonomie je na obrázku 2.3. Základem je kořenová entita (root 

entity) „Událost“, ke které jsou přiřazeny subentity „Letiště“, „Letadlo“, „Letový 

prostor“, „Navigační služby“, apod. Subentity mohou mít přiřazené další subentity a ty 

zase další. Každá entita, ať už kořenová nebo subentita, obsahuje vlastní atributy 

a jejich hodnoty. 

 

 K úpravě taxonomie slouží sada nástrojů ECCAIRS Taxonomy Design Tools, 

která bude rozebírána v další kapitole této práce. 

 

2.4.2   Repository (Repository Manager) 

 

Celá konfigurace ECCAIRS Reporting System je sestavena a uložena v Repository 

(Úložiště). Repository je jádrem každého systému ECCAIRS – slouží k vkládání, 

vyhledávání a zobrazování dat o hlášených událostech v databázi, uchovává veškeré 

informace a umožňuje správu bezpečnosti systému, jeho chování i uživatelského 

nastavení. Nejde tedy jen o databázi hlášených událostí; virtuálně řídí všechny 

aspekty systému. [16] 

 

 Hlavní úložiště všech získaných dat je pod správou JRC a je označeno jako 

European Central Repository (ECR, v překladu Evropské centrální úložiště). Každý 

stát, který využívá systém ECCAIRS, má stanovený jeden místní orgán, který 

spravuje národní úložiště. Shromážděná data pak tento orgán posílá k uložení 

do ECR. V České republice tento úkol připadá ÚZPLN. [3] 

 Získávání dat z úložiště se provádí online, přímo pomocí systému ECCAIRS, nebo 

offline, kdy správce národního úložiště obdrží e-mail s vytvořenou žádostí 

a na základě této žádosti jsou požadovaná data získána z databáze a odeslána 

původnímu tazateli. Žádost ECCAIRS dostupná na portálu ÚZPLN je v příloze 3. 

 

 Repository je propojeno se serverem ECCAIRS, přičemž může existovat více 

těchto serverů a ty mohou být propojeny s různými Repository. Práci s Repository 

umožňuje nástroj ECCAIRS Repository Manager, který bývá nainstalován společně 

se serverem ECCAIRS. Repository Manager se spojuje se serverem ECCAIRS a ten 

zase s Repository – toto propojení funguje jak na stejném počítači, tak i na všech 

počítačích připojených k síti nebo přes internet. 

 

 
Obr. 2.4: Okno Repository Manageru pro spojení se serverem ECCAIRS [16] 
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 Prvním krokem k vytvoření Repository pomocí nástroje Repository Manager je 

spojení Repository Manageru se serverem ECCAIRS, viz obrázek 2.4. 

 

 Po spojení se serverem se již otevře hlavní okno Repository Manageru, 

viz obr. 2.5. Hlavní okno obsahuje: 

- Tři panely: 

- Repository List (Seznam úložišť) – vlevo; seznam všech úložišť 

definovaných na daném serveru 

- Repository Structure (Struktura úložiště) – uprostřed; strom položek, 

které tvoří dané úložiště vybrané v Repository List 

- Properties Panel (Panel vlastností) – vpravo; zobrazuje vlastnosti 

spojené s položkou, která je právě označena v Repository Structure 

- Menu bar (Lišta menu) – všechny dostupné funkce Repository Manageru 

- Toolbar (Lišta nástrojů) – funkce Repository Manageru ve formě ikon 

- Status bar (Stavová lišta) – zobrazuje informace o stavu 

 

 

 
 

Obr. 2.5: Hlavní okno Repository Manageru [16] 
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 V tomto okně je pak možné nastavit si celé Repository podle svých potřeb, pro 

správnou funkci Repository ale není třeba nastavovat úplně vše. Nezbytné je 

nastavení hlavních vlastností Repository: 

- Name (Název Repository) 

- Organisation identification (Identifikace organizace) 

- Database connection (Propojení databáze) 

- Taxonomy (Taxonomie) 

 Dále je nutné vytvořit hlavní profily: 

- Browser Profile (Prohlížeč) – definuje, jak se bude chovat hlavní aplikace 

ECCAIRS pro Windows 

- Security Profile (Bezpečnost) – nastavení bezpečnosti Repository 

- View Profile (Náhled) – definuje způsob, jakým uživatel interaguje s daty 

hlášených událostí uložených v Repository 

 

 Nyní je třeba v položce Roles (Role) vytvořit novou roli. Role představuje soubor 

profilů a potřebuje mít minimálně výše zmíněné profily Browser, Security a View, 

a nakonec zbývá vytvořit v položce Users (Uživatelé) nového uživatele, který je 

přiřazen určité roli a převezme všechny profily definované v této roli. Pomocí funkce 

Repository > Validate je možné zkontrolovat vnitřní strukturu Repository a také její 

kompatibilitu s přiřazenou taxonomií. Celý proces je třeba uložit pomocí funkce Save 

changes nebo Update. [16] 

 

2.4.3   Query 

 

Informace o vybraných událostech jsou z databáze získávány pomocí Query (Dotaz), 

které je sestaveno uživatelem. Dotazy jsou vytvářeny pomocí tzv. QueryBuilderu 

(Vytváření dotazů) a samotná formulace dotazu je velice jednoduchá, bez potřeby 

znalosti programování. Základním blokem dotazu je kritérium (criterion), což je 

požadavek na konkrétní atribut. Kritérium může být postaveno na jakémkoli atributu 

současné taxonomie. Je také možné provádět kombinace kritérií pomocí logických 

operátorů AND (A) a OR (NEBO). 

 

 Na obrázku 2.6 je uveden příklad kritérií dotazu. Podle tohoto dotazu mají být 

vybrány události, kde atribut „Množství oblačnosti“ odpovídá hodnotě „Zataženo“ 

a zároveň atribut „Viditelnost“ odpovídá hodnotě „Méně než 100“ (jednotkou jsou 

v tomto případě stopy – feet). 
 

 
Obr. 2.6:  Příklad Dotazu (Query) [4] 
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 Dotazy si lze uložit do QueryLibrary (Knihovna dotazů), přičemž tato knihovna 

může obsahovat libovolné množství těchto dotazů. Knihovna dotazů umožňuje 

vytvářet, upravovat i mazat dotazy a uspořádat dotazy do skupin. Dotazy také mohou 

být v rámci Knihovny dotazů přiřazeny k určité kategorii (category) a uživatel si tak 

může dotazy logicky uspořádat. [4] 

  

2.4.4   ECCAIRS Browser 

 

ECCAIRS Browser neboli Prohlížeč je klíčovým komponentem ECCAIRS Reporting 

System. Umožňuje vkládat, upravovat, zobrazovat a vyhledávat data o událostech 

uložených v databázi. Browser umožňuje komplexní a jednoduché nahlížení na data 

jednotlivých vložených událostí. 

 

 
 

Obr. 2.7: Okno ECCAIRS Browser 
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 Hlavní okno nástroje Browser je na obrázku 2.7. Skládá se z několika základních 

prvků: 

- Menu bar (Lišta menu) – umožňuje přístup ke všem funkcím Browseru 

- Toolbar (Lišta nástrojů) – sada pro rychlejší přístup k funkcím Browseru 

- Information Panel (Informační panel) – plocha, na které jsou zobrazována 

data o události; obsahuje dva subpanely: 

- Topic-tree sub-panel (Strom témat) – vlevo, zobrazuje témata dané 

události uspořádaná ve stromové struktuře 

- Topic-data sub-panel (Data tématu) – vpravo, zobrazuje informace 

o dané události prostřednictvím atributů a jejich hodnot rozdělených 

do sekcí, které jsou přiřazeny tématu zvolenému ve stromu témat 

- Occurrence List Panel (Panel seznamu událostí) – zobrazuje seznam 

dalších událostí nalezených v databázi podle zadaného dotazu (Query)  

- Status bar (Stavová lišta) – zobrazuje základní informace o uživateli, počtu 

událostí v panelu seznamu událostí, počtu vybraných událostí, o taxonomii, 

atd. 

 

 Browser umožňuje vytvářet nové události pomocí funkce Occurrence > New. 

Je třeba vybrat náhled, ve kterém bude uživatel informace vyplňovat, viz obrázek 2.8. 

Události je možné i duplikovat, upravovat, mazat, tisknout nebo převést do formátu 

PDF. 

 

 
 

Obr. 2.8: Vytvoření nové události v ECCAIRS Browser 

  

  V databázi hlášení událostí lze události filtrovat pomocí Query. Prostřednictvím 

funkce Database > Built query se otevře nové okno, kde se funkcí Library > New 

vytvoří knihovna dotazů, ve které je možné vytvářet a ukládat do ní dotazy, 

viz obrázek 2.9. 
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Obr. 2.9: Knihovna dotazů [4] 

 

 Funkce View > View with umožňuje uživateli vybrat si náhled, pomocí kterého 

budou zobrazeny informace obsažené v hlášení události, viz obrázek 2.10. 

Po instalaci systému ECCAIRS je několik základních náhledů již zabudovaných. 

Je také možné vybrat si, jaké funkce budou zobrazeny v Liště nástrojů a jestli bude 

zobrazen panel seznamu událostí. 

 

 
 

Obr. 2.10: Výběr náhledu pro ECCAIRS Browser 
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 Barevnost uživatelského prostředí lze měnit pomocí funkce View > Options > 

Appearance, viz obrázek 2.11. [4] 

 

 
 

Obr. 2.11: Úprava barevnosti uživatelského prostředí 

 

2.4.5   ECCAIRS Grapher 

 

ECCAIRS Grapher je nástroj pro vytváření grafů, který vytváří nejpoužívanější 

statistické grafy. Ačkoli Grapher není nástroj zcela vybavený pro datovou analýzu, 

tato aplikace umožňuje vytvářet celou řadu grafů, které ilustrují trendy z vložených 

Událostí. Je možné vytvářet 2D i 3D grafy a ukázat tak závislost mezi dvěma nebo 

třemi parametry. Základní data grafu mohou být importována do různých aplikací, 

jako například MS Excel. 

 

 Grafy se skládají ze 4 základních elementů: 

- Dotaz, který definuje podmnožinu událostí z databáze, která je použita 

k vytvoření grafu 

- Osa X definovaná elementy z databáze (hodnoty určitých vlastností), které 

jsou zobrazeny v grafu horizontálně 

- Osa Y definující datové série vykreslené v grafu pro každou hodnotu osy X. 

Data na ose Y mohou být 2 typů: databázové dotazy plynoucí z hodnot nebo 

jiných vlastností, nebo výpočty z jiných datových sérií 

- Volitelná osa Z, která definuje kategorie pro vykreslení X a Y přidáním třetí 

dimenze do grafu  



 

 

NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 TAXONOMY DESIGN TOOLS 

25 

 Hlavní okno ECCAIRS Grapher (viz obrázek 2.12) se skládá ze tří částí: 

- Menu bar (Lišta menu) – umožňuje přístup ke všem funkcím Grapheru 

- Toolbar (Lišta nástrojů) – sada pro rychlejší přístup k vybraným funkcím 

Grapheru 

- Workspace (Pracovní plocha) – kde je zobrazena Graph Library (Knihovna 

grafů) a otevřené grafy [4] 

 

 
 

Obr. 2.12:  ECCAIRS Grapher [4] 

 

2.4.6   ECCAIRS Data Manager 

 

 ECCAIRS Data Manager je aplikace obsahující sadu výkonných nástrojů 

pro ECCAIRS Reporting System. 

 Nástroj Exporter (Exportér) umožňuje vytváření vlastních upravených zpráv, 

vyhledávání textu na základě hodnot atributů, předávání dat do nekompatibilních 

systémů se systémem ECCAIRS nebo vytváření de-identifikovaných souborů. 

 Nástroj Data Exchanger (Výměna dat) obsahuje čtyři základní funkce: 

1) Načítání dat ze souboru události 

2) Ukládání dat do souboru události 

3) Kopírování dat mezi jednotlivými úložišti 

4) Odstraňování všech událostí z úložiště 
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 Nástroj Restorer (Obnovení) slouží k případnému obnovení a identifikování de-

identifikovaných souborů. 

 Nástroj Data Quality (Kvalita dat) slouží ke kontrole kvality dat obsažených 

v hlášení události. Kvalita dat je vyhodnocována na základě pravidel umístěných 

v tzv. Rule Libraries (Knihovny pravidel). [4] 

 

2.4.7   Ostatní aplikace ECCAIRS 

 

Sada produktů ECCAIRS je složena z mnoha aplikací, které umožňují vytvářet 

a spravovat databázi hlášení leteckých událostí. Mimo již zmíněných aplikací 

a nástrojů existují i aplikace pro: 

 

- Data Entry and Retrieval (Vkládání a vyhledávání dat) je aplikace, která 

vkládá data o nehodách a incidentech do ECCAIRS Repository 

- Analysis (Analýza) – aplikace napomáhající při analýze uložených dat 

- Utilities (Služby) – užitečné aplikace, které zastávají funkce, které nejsou 

dostupné v rámci standardního softwaru, a jsou užitečné pro koncové 

uživatele systému 

- System Tools (Systémové nástroje) – usnadňují údržbu systému ECCAIRS 

- Data Integration (Integrace dat) – aplikace potřebné k provedení integrace 

dat na národní a evropské úrovni 

- Data Dissemination (Šíření dat) – umožňují šíření dat na úrovni organizace, 

státu nebo Evropské unie. [4] 
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3   MOŽNOSTI MODIFIKACÍ SYSTÉMU ECCAIRS 
 

Verze ECCAIRS 5 umožňuje uživatelům podílet se na vymezení taxonomie a upravit 

si svoji vlastní taxonomii. K tomu jsou určeny Taxonomy Projects a sada Taxonomy 

Design Tools. Taxonomy Projects obsahují reálnou strukturu, entity a jejich relace, 

atributy a jejich hodnoty. Na základě Taxonomy Projectu může být generován 

Taxonomy File, neboli Dictionary, a ten může být použit jako vstup pro design 

rozhraní. [11] 

 

 Design uživatelského rozhraní je pak možno upravovat pomocí sady User 

Interface Design. Tato sada nástrojů umožňuje editovat nebo vytvářet vlastní sekce 

a náhledy. Výsledkem tak může vlastní zobrazení dat hlášených událostí v ECCAIRS 

Browseru. 

 

3.1   ECCAIRS 5 Taxonomy Design Tools 

 

Sada Taxonomy Design Tools (TaxDes) je složena z pěti nezávislých nástrojů: 

 

- Administration – správa taxonomie 

- Manager – správa taxonomie 

- Customisation – úprava atributů taxonomie 

- Translation – překlad atributů taxonomie 

- Value Manager – úprava hodnot atributů taxonomie [11] 

 

 Jednotlivé nástroje budou podrobněji rozebrány v následujících kapitolách. 

Nástroje TaxDes Administration a TaxDes Manager jsou určeny pouze pro vybrané 

organizace, proto se tato práce bude více soustředit na nástroje, které jsou dostupné 

běžným uživatelům systému ECCAIRS. 

 

3.1.1   Taxonomy Designer (Administration) 

 

Tento nástroj je dostupný pouze organizaci JRC. Umožňuje: 

- Vytvářet novou taxonomii 

- Upravovat taxonomii (strukturu, hodnoty) 

- Vytvářet upravitelné atributy (Custom Atributes) 

- Vytvářet vydání (Release) 

- Exportovat/importovat vydání 

- Generovat překládací projekt (Translation Project) 

- Importovat překládací projekt 

- Generovat skripty pro databáze 

- Vytvářet soubor taxonomie (Taxonomy Dictionary) [11] 
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3.1.2   Taxonomy Designer (Manager) 

 

Nástroj Taxonomy Designer (Manager) je dostupný pro JRC a agenturu EASA. 

Rozsah jeho funkcí je mírně omezený oproti nástroji Administration. Umožňuje: 

- Upravovat taxonomii (strukturu, hodnoty) 

- Vytvářet upravitelné atributy 

- Vytvářet vydání 

- Exportovat/importovat vydání 

- Generovat překládací projekt 

- Importovat překládací projekt  

- Vytvářet soubor taxonomie [11] 

 

3.1.3   Taxonomy Designer (Customisation) 

 

Taxonomy Designer (Customisation) lze využít v módu Custom nebo Profile. Funkce 

v obou módech jsou velice podobné. V módu Custom je možné: 

- Vytvořit projekt na základě jednotné taxonomie (Custom Project) 

- Upravit upravitelný atribut 

- Vytvořit seznam hodnot pro upravitelné atributy 

- Vytvářet vydání 

- Exportovat/importovat vydání 

- Vytvářet soubor k úpravě taxonomie (Custom Dictionary) 

V módu Profile je možné: 

- Vytvořit projekt na základě jednotné taxonomie (Profile Project) 

- Upravit atribut 

- Měnit povinnost vyplnění atributů 

- Filtrovat hodnoty pro specifický seznam hodnot 

- Vytvářet vydání 

- Vytvářet soubor k úpravě taxonomie 

 

 Úprava taxonomie probíhá v okně Working Draft (Pracovní návrh), 

viz obrázek 3.1. Okno Working Draft obsahuje: 

- Tři panely: 

- Entity list panel (Seznam entit) – vlevo, zobrazuje všechny entity 

a subentity obsažené v dané taxonomii a jejich vzájemné vztahy 

- Atribute list panel (Seznam atributů) – uprostřed, zobrazuje atributy 

vložené v entitě, která je právě označena v Entity list panelu 

- Atribute properties panel (Vlastnosti atributu) – vpravo, zobrazuje 

vlastnosti atributu, který je právě označen v Atribute list panelu 

- Atribute Filtering and Navigation bars (Lišta filtrování a navigace mezi 

atributy) – umožňuje filtrovat a vyhledávat atributy na základě taxonomie, 

skupiny, typu nebo přímo pořadového čísla atributu 
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- Menu bar (Lišta menu) – obsahuje všechny dostupné funkce nástroje 

- Toolbar (Lišta nástrojů) – obsahuje funkce nástroje v ikonách 

- Status bar (Stavová lišta) – zobrazuje informace o souboru 

 

 
 

Obr. 3.1: Okno Working Draft nástroje TaxDes Customisation 

 

 Nástroj TaxDes Customisation umožňuje především editovat upravitelné atributy, 

které jsou součástí každé verze taxonomie (na obrázku 3.1 jsou psané zeleně 

kurzívou), pomocí funkce Customize Atribute. Samotná úprava probíhá v Properties 

panelu – lze měnit název, popis, detailní popis, vysvětlení, povinnost vyplnění 

hodnoty atributu, apod.  

 

 Mezi další funkce patří tisk zpráv o taxonomii nebo jejich generování ve formátu 

PDF prostřednictvím funkce Taxonomy > Print Preview, resp. Taxonomy > Generate 

PDF, kdy se otevře nové okno s výběrem předvolených zpráv o taxonomii a dalšími 

možnostmi úpravy zprávy. Funkce Taxonomy > Update Taxonomy uloží provedené 

změny v souboru a pomocí funkce Taxonomy > Check Structure lze zkontrolovat 

správnost úprav. 

 

 Verze se vytváří pomocí funkce Make Release. Po otevření vytvořené verze se 

zobrazí okno podobné oknu Working Draft, jsou zde ale dostupné jiné funkce, 

viz obrázek 3.2. V tomto okně již nelze upravovat atributy.  
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 Funkce Translation > Generate Translation Project umožňuje vygenerovat 

Translation Project určený k překladu taxonomie v nástroji TaxDes Translation. 

Přeložený soubor Taxonomy Project lze importovat zpět prostřednictvím funkce 

Translation > Import Translation Project. 

 

 
 

Obr. 3.2: Okno verze v TaxDes Customisation 

 

 I v tomto okně lze tisknout zprávy o taxonomii nebo je generovat ve formátu PDF 

pomocí funkcí Taxonomy > Print Preview, resp. Taxonomy > Generate PDF. Funkce 

Taxonomy > Export Description vytvoří soubor ve formátu XLS s tabulkou všech entit 

v taxonomii s jejich popisem v abecedním pořádku, nejsou tedy patrné relace mezi 

entitami. Funkce Taxonomy > Export Statistics for Value list vytvoří soubor 

ve formátu XLS s tabulkou seznamu hodnot pro jednotlivé atributy v taxonomii, 

včetně jejich popisu, pokud je zadán. 

 

 Výstupem úpravy taxonomie v TaxDes Customisation je upravovací soubor 

taxonomie, tzv. Custom Dictionary, který je možné generovat funkcí Generate > 

Make Custom Dictionary. Soubor Custom Dictionary má příponu .cust a je použitelný 

v mnoha dalších nástrojích systému ECCAIRS, například v dále zmíněném Section 

Designeru nebo View Desgineru, které vytvářejí projekty na základě taxonomie, a při 

použití Custom Dictionary jsou schopné pracovat i se změnami v taxonomii 

uloženými právě v tomto souboru. [11] 

 

3.1.4   Taxonomy Designer (Translation) 

 

Taxonomy Designer (Translation) je nástroj sloužící k překladu atributů taxonomie. 

Překlad se uskutečňuje v Translation Project souboru (přípona .etpt), který byl dříve 

generován z vydání Customisation Projectu v nástroji TaxDes Customisation. 
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 Po otevření Translation project souboru se otevře překládací okno nástroje 

TaxDes Translation, viz obrázek 3.3. Toto okno obsahuje: 

- Workspace (Pracovní prostor) – je rozdělený na dva panely: 

- Item-list panel (Seznam položek) – vlevo, zobrazuje položky, které 

mohou být přeloženy 

- Translation panel (Překládací panel) – vpravo, slouží k přímému 

překladu položky, která je právě označena v Item-list panelu 

- Menu bar (Lišta menu) – umožňuje přístup ke všem funkcím nástroje 

- Toolbar (Lišta nástrojů) – zobrazuje funkce nástroje jako ikony 

- Status bar (Stavová lišta) – zobrazuje informace o souboru 

 

 
Obr. 3.3: Překládací okno nástroje TaxDes Translation 

 

 Překlad položek se provádí v Translation panelu, který je rozdělen na sekce 

Description (Popis), Detailed Description (Detailní popis) a Explanation (Vysvětlení). 

Každá tato sekce obsahuje pole pro originální a pro přeložený text, přičemž 

po vepsání přeloženého textu pole pro přeložený text zezelená. Je možné zkopírovat 

originální text do překládacího pole pomocí funkce Copy (Kopírovat). Lze také 

obnovit původní texty všech přeložených položek prostřednictvím funkce 

Edit > Restore Original Values. Funkce Edit > Search umožňuje vyhledávat položky 

v taxonomii. 

 

 Není nutné překládat položky přímo v TaxDes Translation. Pomocí funkce File > 

Export to Excel lze soubor převést do formátu XLS a překlad provést v MS Excel. 

Přeložený soubor je následně importován zpět funkcí File > Import from Excel. 

 

 I zde je možné tisknout zprávy o taxonomii nebo je generovat ve formátu PDF, 

stejně jako v nástroji TaxDes Customisation. [12] 
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3.1.5   Taxonomy Designer (Value Manager) 

 

Tento nástroj umožňuje organizacím spravovat hodnoty atributů (především v jejich 

národní databázi), konkrétně upravovat hodnoty ve specifickém seznamu hodnot 

nebo větvi seznamu hodnot. TaxDes Value Manager pracuje se soubory Value List 

Project, které je možné generovat pomocí nástroje TaxDes Manager, kdy je pak 

možné upravovat hodnoty všech atributů, nebo TaxDes Customisation, kdy je možné 

upravovat pouze hodnoty upravitelných atributů. 

 

 Po otevření Value List Project souboru se otevře okno Value List Management, 

viz obrázek 3.4. Okno sestává z: 

- Menu bar (Lišta menu) – obsahuje všechny dostupné funkce okna 

- Toolbar (Lišta nástrojů) – funkce okna ve formě ikon 

- Central panel (Centrální panel) – zobrazeny seznamy hodnot k úpravě 

- Status bar (Stavová lišta) – informace o stavu souboru 

 

 
 

Obr. 3.4: Okno Value List Management [13] 

 

 Dvojklik na daný seznam hodnot nebo funkce Edit > Values otevře okno Manage 

Values for List, viz obrázek 3.5, které obsahuje: 

- Menu bar (Lišta menu) – všechny dostupné funkce okna 

- Toolbar (Lišta nástrojů) – funkce okna ve formě ikon 

- Dva pracovní panely: 

- Value Tree Navigation Panel (Navigační panel stromu hodnot) – 

zobrazuje hodnoty v seznamu hodnot a jejich relace 

- Value Properties Panel (Panel vlastností hodnoty) – zobrazuje 

vlastnosti dané hodnoty označené v navigačním panelu 

- Status bar (Stavová lišta) – zobrazuje informace o stavu souboru 
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Obr. 3.5: Okno Manage Values for List [13] 

 

 Pomocí menu tlačítka Edit je možné přidávat hodnoty (Add Value), přidávat 

subhodnoty (Add Child Value), mazat hodnoty (Remove Value), obnovovat hodnoty 

(Restore Value) a přeskupovat pořadí hodnot ve struktuře stromu pomocí šipek. 

Každou hodnotu lze upravit v panelu vlastností. 

 

 Soubor Value List Project je možné exportovat do programu MS Excel 

prostřednictvím funkce File > Export to Excel. Upravený soubor z MS Excel 

se importuje zpět do nástroje Value Manager funkcí File > Import from Excel. 

 

 Tisk zpráv umožňuje funkce File > Print Preview a generování zpráv do formátu 

PDF funkce File > Generate PDF File. [13] 

 

3.2   ECCAIRS User Interface Design 

 

Náhledy zabudované v ECCAIRS při instalaci nemusí vždy všem organizacím nebo 

přímo jednotlivým uživatelům vyhovovat. K tomu je určena právě sada User Interface 

Design, která sestává ze dvou nástrojů: 

 

- Section Designer – pro úpravu již vytvořených a vytváření nových sekcí 

z atributů taxonomie 

- View Designer – pro úpravu nebo vytváření nových náhledů ze sekcí 
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3.2.1   Section Designer 

 

Systém ECCAIRS ukládá data související s událostmi ve stovkách různých atributů. 

Hodnoty těchto atributů jsou uloženy v databázi ECCAIRS. Některé atributy se týkají 

přímo události (např. datum události), jiné atributy se vztahují ke specifické subentitě 

události (např. subentity letadlo, letiště, apod.). Pozn.: Pokud se události účastnilo 

více letadel, každé má pak svoji subentitu s vlastními atributy a jejich hodnotami. 

 Pro lepší vizualizaci a možné úpravy jsou atributy seskupovány v sekcích. Nástroj 

Section Designer pak umožňuje organizacím využívajícím systém ECCAIRS vytvářet 

a upravovat jejich vlastní sekce. 

 Samotný Section Designer je součástí sady ECCAIRS User Interface Design 

(Design uživatelského prostředí) a kromě vytváření nových sekcí umožňuje také 

kombinovat různá rozvržení zobrazení, vkládat text, názvy atributů a ovládání 

pro hodnoty atributů. 

 

 Při vytváření nové sekce (Section Project), viz obrázek 3.6, je nutné specifikovat 

soubor taxonomie (Taxonomy Dictionary) a jednu z entit, nejčastěji tzv. kořenovou 

entitu – událost, na kterých bude tato sekce založena. V dané sekci je pak možné 

pracovat pouze s atributy příslušejícími k této entitě, případně k jejím subentitám. 

Ve formuláři pro vytvoření nové sekce si lze zvolit název sekce (tento údaj je 

povinný), popis sekce, detailní popis sekce, číslo vydání a je možné vložit editovací 

soubor. 
 

 
 

Obr. 3.6:  Formulář vytvoření nové sekce v nástroji Section Designer 

 

 Do polí pro název a popisy sekce lze vepsat nebo vložit jakýkoli text. Číslo verze 

tvoří čtyři čísla, jejichž význam je popořadě hlavní vydání (major release), vedlejší 

vydání (minor release), revize (revision) a sestavení (build). Výchozí číslo verze je 
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1.0.0.0 a lze upravit. Editovací soubor se používá, pokud jsme například potřebovali 

pomocí Taxonomy Designer (Customisation) doplnit další atributy úpravou 

editovatelných atributů. Editovací soubor je pak generován přímo z nástroje TaxDes 

Customisation a má příponu .cust.  

 

 Vlastní editace sekce probíhá v hlavním okně Section Designeru, viz obrázek 3.7. 

Okno obsahuje: 

- Menu bar (Lišta menu) – všechny dostupné funkce Section Designeru 

- Toolbar (Lišta nástrojů) – všechny dostupné funkce Section Designeru 

zobrazené pomocí ikon 

- Toolbox panel (Panel nástrojů) – vlevo, pro specifikaci druhu prvku 

- Canvas panel (Panel tabulky sekce) – uprostřed, tabulka sekce, kam jsou 

vkládány prvky 

- Properties panel (Panel vlastností) – vpravo, vlastnosti týkající se celé sekce 

nebo vybraného prvku 

- Layout switch tab-bar (Lišta výběru rozvržení zobrazení) – výběr rozvržení 

zobrazení 

- Status bar (Stavová lišta) – informace o sekci (taxonomie, název sekce, číslo 

vydání, atd.) 

 

 Každá sekce může být přizpůsobena, aby vyhovovala různým zobrazovacím 

módům nebo médiím, přičemž tyto módy a média mohou vyžadovat různá umístění 

a velikost políček atributů, panelů, apod. Při vytváření sekce je možné použít jedno 

z pěti rozvržení zobrazení: 

- Windows Form Edit (Upravitelné zobrazení pro Windows) – pro zobrazení 

a úpravu dat v sekci při použití ECCAIRS Browser pro Windows; 

toto rozvržení je výchozí 

- Windows Form Read-Only (Zobrazení pro Windows pouze pro čtení) – 

pro zobrazení dat v sekci při použití ECCAIRS Browser pro Windows 

bez možnosti úpravy 

- Web Form Edit (Upravitelné zobrazení pro web) – pro zobrazení a úpravu dat 

v sekci při použití aplikace WebDAS 

- Web Form Read-Only (Zobrazení pro web pouze pro čtení) – pro zobrazení 

dat v sekci při použití aplikace WebDAS bez možnosti úpravy 

- Report (Zpráva) – pro zobrazení dat v sekci ve verzi pro tisk  
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Obr. 3.7:  Hlavní okno Section Designeru 

  

 Základní podobu sekce lze nastavit v hlavním okně Section Designeru pomocí 

vybrání nabídky View > Options, která otevře okno se čtyřmi záložkami: 

- Section Properties (Vlastnosti sekce) – umožňuje určit počet sloupců a řádků 

sekce, vybrat, které rozměry buněk se budou automaticky měnit se změnou 

velikosti okna, kde bude výsledek zobrazen, a jestli bude viditelný okraj sekce 

- Table Properties (Vlastnosti tabulky) – lze měnit výchozí šířku sloupců 

a výšku řádků a opět vybrat, které rozměry buněk se budou automaticky měnit 

se změnou velikosti okna 

- Control Properties (Vlastnosti prvku) – možnost měnit výchozí šířku a výšku 

prvků vkládaných do tabulky (tyto rozměry měly být vždy menší, než jsou 

rozměry buňky, aby byl zobrazen celý obsah prvku) a volit velikost okrajů 

v buňce, zarovnání a pozici textu 

- Font Properties (Vlastnosti písma) – umožňuje výběr fontu a velikost textu 

obsaženého v prvcích 

 

 Uživatel si může vybrat ze seznamu použitelných prvků v Toolbox Panelu vlevo 

takový druh prvku, jaký právě potřebuje (např. atribut, jeho hodnotu, entitu, vlastní 

text, obrázek, atd.). Je možné si zvolit, kolik řádků a sloupců daný prvek obsadí, 

a následně jej pomocí myši přesunout na požadované místo v připravené tabulce 

sekce. V Properties panelu je pak možné všechny tyto prvky upravovat – měnit jeho 

umístění v tabulce, jeho rozměry, název, zarovnání a odsazení textu, apod. Tabulka 

sekce s vloženými atributy je na obrázku 3.8. 
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Obr. 3.8: Tabulka sekce s vloženými atributy 

 

 Sekci si lze prohlédnout pomocí File > Section Preview. Otevře se nové okno, kde 

je sekce zobrazena tak, jak bude vypadat v ECCAIRS Browseru, viz obrázek 3.9. 

Section Preview umožňuje generovat data sekce, tedy automaticky vyplnit hodnoty 

atributů náhodným textem, a také změnit barvy různých částí sekce (pozadí, text, 

okraje). Je možné si vyzkoušet i vlastní vyplňování hodnot atributů. [14] 

 

 
 

Obr. 3.9: Section Preview 
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3.2.2   View Designer 

 

Nástroj View Designer je posledním článkem při vytváření vlastního uživatelského 

prostředí. S jeho pomocí lze uspořádat sekce vytvořené v Section Designeru 

do nového náhledu (View) a dále tento náhled upravovat. Mimo to je možné vytvořit 

Strom události (Topic Tree) a rozdělit zobrazení sekcí do témat. 

 

 Vytvoření nového náhledu probíhá obdobně jako při vytváření nové sekce. Musí 

být zvolen název náhledu, číslo vydání je předvoleno na 1.0.0.0, ale je možné jej 

změnit, popis nového náhledu je nepovinné pole, zato povinné je opět vybrat soubor 

katalogu taxonomie, na kterém bude tento náhled založen. I zde je možné vložit 

editovací soubor, pokud je potřeba. 

 

 Hlavní okno View Designeru, viz obrázek 3.10, obsahuje: 

- Topic-tree panel (Panel stromu témat) – vlevo, zobrazuje strom témat a k nim 

příslušející sekce, umožňuje vybírat, přidávat, odebírat témata a sekce 

- Properties panel (Panel vlastností) – vpravo, zobrazuje vlastnosti témata 

nebo sekce, která je právě označena v Topic-tree panelu 

- Menu Bar (Lišta menu) – všechny dostupné funkce View Designeru 

- Toolbar (Lišta nástrojů) – všechny dostupné funkce View Designeru 

zobrazené v ikonách 

- Layout switch tab-bar (Lišta výběru rozvržení zobrazení) – výběr rozvržení 

zobrazení 

- Status bar (Stavová lišta) – zobrazuje informace o náhledu – jeho název, 

číslo verze, katalog taxonomie, na kterém je náhled založen, a umístění 

náhledu v počítači 

 

 Stejně jako pro sekce, tak i pro náhledy je možné zvolit různá rozvržení zobrazení 

podle zvoleného zobrazovacího média nebo módu. Pro náhledy jsou dostupná 

celkem čtyři rozvržení zobrazení: 

- Window – používané pro ECCAIRS Browser pro Windows; toto rozvržení je 

výchozí 

- Web – používané pro aplikaci WebDAS 

- Report (Zpráva) – používané pro zobrazení dat náhledu v módu pro tisk 

zprávy 

- PDF Form (Formulář PDF) – používané pro předávání dat samostatného 

hlášení události a následný import do ECCAIRS Reporting System 
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Obr. 3.10: Hlavní okno View Designeru 

 

 V nově vytvořeném náhledu sestává Topic tree pouze z tématu Událost 

(Occurrence). Subtémata jsou přidávány pomocí funkce Edit > Add a Child Topic 

a toto vložené subtéma je upravitelné v Properties panelu. Lze volit název 

subtématu, jeho ikonu a také font, styl a velikost písma. Kořenové téma i každé 

subtéma mohou mít přiřazeny různé sekce, které se v ECCAIRS Browseru zobrazí 

v panelu po označení daného tématu. Subtémata je samozřejmě možné přesouvat 

v rámci Topic tree výš nebo níž, případně je úplně odstranit. 

 

 Sekce se do View Designeru importují pomocí funkce Section Reference. Otevře 

se nové okno, kde pomocí tlačítka + vpravo můžeme vybrat požadované sekce 

ze složky v počítači a vložit je do View Designeru, viz obrázek 3.11. Po vložení sekcí 

vidíme, kolik sekcí jsme celkem vložili a základní informace o těchto sekcích, jako je 

název, číslo vydání, název entity, na které je sekce založená, atd. Pomocí dalších 

tlačítek vpravo je možné vybrané sekce odstranit, zobrazit si jejich vlastnosti nebo 

si najít jejich umístění v počítači. Funkce Extract Sections umožňuje extrahovat 

sekce a vytvořit samostatné soubory těchto sekcí (přípona .esd) například v případě, 

že by se původní soubory ztratily.  
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Obr. 3.11: Okno Section References ve View Designeru 

 

 Pomocí funkce Edit > Manage Sections se přiřazují sekce k daným tématům. 

Opět se otevře nové okno se dvěma dílčími okny, přičemž v okně vlevo jsou vidět 

dostupné sekce, které byly dříve importovány do tohoto náhledu, viz obrázek 3.12. 

Prostřednictvím šipek uprostřed je možné vybírat z dostupných sekcí ty, které mají 

být přiřazeny danému vybranému tématu. 

 

 
 

Obr. 3.12: Okno Manage Sections ve View Designeru 

 

 Pořadí sekcí v náhledu lze poté upravit ve vlastnostech daného tématu 

v Properties panelu pomocí šipek. 

 

 Náhled je možné si prohlédnout prostřednictvím funkce File > Preview, obdobně 

jako v Section Designeru. Otevře se nové okno, kde se náhled zobrazí tak, jak bude 
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zobrazen v ECCAIRS Browseru, včetně Topic-tree panelu vlevo, viz obrázek 3.13. 

Při vybrání tématu jsou zobrazeny sekce, které jsou tomuto tématu přiřazeny, 

ve zvoleném pořadí. Zkušebně vyplnit hodnoty atributů lze pomocí funkce File > 

Generate complete data a v záložce View lze přepínat mezi rozvrženími zobrazení 

a také měnit barvy různých částí celého náhledu. [15] 

 

 
 

Obr. 3.13: Okno Preview ve View Designeru 

 

  



 

 

NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 TAXONOMY DESIGN TOOLS 

42 

4   NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 TAXONOMY 

    DESIGN TOOLS 
 

Informace jednotlivých událostí v databázi se v ECCAIRS Browseru zobrazují 

v různých náhledech. Již bylo zmíněno, že v běžné instalaci ECCAIRS je 

zabudováno několik základních náhledů. Žádný z těchto náhledů ale neposkytuje 

možnost zobrazení všech informací o události na jedné stránce – informace jsou 

rozděleny do různých témat a uživatel je nucen projít všechna tato témata v Topic-

tree panelu, aby mohl zjistit veškeré údaje. Proto jsem v rámci této diplomové práce 

využila sady ECCAIRS 5 Taxonomy Design Tools a User Interface Design 

k vytvoření nového náhledu pro ECCAIRS Browser, který má podobu formuláře 

hlášení události ÚZPLN. 

 

 Pro vytvoření náhledu bylo nutné i upravit taxonomii, konkrétně přeložit atributy, 

které jsou obsažené ve formuláři pro hlášení události. Ve výsledném náhledu, stejně 

jako v původním formuláři, jsou veškeré texty uvedeny anglicky i česky. Postupem 

překladu taxonomie a vytvoření nového náhledu se zabývá následující podkapitola. 

 

4.1   Postup překladu taxonomie a vytvoření nového náhledu 

 

V této podkapitole je popsán postup překladu původní taxonomie pomocí nástroje 

TaxDes Translation a následné vytvoření nového náhledu pro ECCAIRS Browser 

prostřednictvím nástrojů Section Desginer a View Designer. Grafické schéma 

posloupnosti kroků je v příloze 6 a výsledná podoba formuláře je v příloze 7 této 

práce. 

 

TaxDes Translation 

Podle manuálů k nástrojům TaxDes Customisation a TaxDes Translation má nástroj 

Translation pouze překládací okno a Translation Project soubor k překladu 

se generuje z nástroje Customisation. Ve skutečnosti ale generovaný Translation 

Project z nástroje Customisation není kompatibilní s nástrojem Translation. Proto je 

třeba při překladu taxonomie nástroj Customisation úplně vynechat a použít funkci 

File > Reverse Engineering v nástroji Translation. 
 

 
 

Obr. 4.1: Funkce Reverse Engineering v nástroji Translation 
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 Tato funkce otevře okno pro vytvoření nového projektu, viz obrázek 4.2, kde je 

na výběr Taxonomy Project (Projekt taxonomie), Customisation Project (Upravovací 

projekt) a Profile Project (Profilový projekt). Aby potom bylo možné generovat nový 

soubor taxonomie, je potřeba vybrat Taxonomy Project, který se vytváří na základě 

původní taxonomie. Je pak otevřeno stejné editovací okno, jako v nástroji 

Customisation, pouze s jedinou změnou – není možné generovat Custom Dictionary 

(.cust), ale generuje se Dictionary (.dict), který pak slouží jako nový soubor 

taxonomie. 

 

 
 

Obr. 4.2: Okno Reverse Engineering nástroje TaxDes Translation 

 

 Dalším krokem je vytvoření vydání (funkce File > Make Release, viz obr. 4.3) 

a v okně vydání generovat překládací soubor pomocí funkce Translation > Generate 

Translation Project, viz obrázek 4.4. 
 

 
 

Obr. 4.3: Vytvoření nového vydání pomocí funkce Make Release 
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Obr. 4.4: Generování, resp. importování Translation Project souboru  

v otevřeném okně vydání 

 

 Po otevření vygenerovaného Translation Project souboru (.etpt) se otevře 

překládací okno nástroje TaxDes Translation. V políčku Table type (Druh tabulky) je 

třeba vybrat Taxonomy Tables (Tabulky Taxonomie) a následně se v levém panelu 

zobrazí seznam atributů k překladu. Označení atributu zaktivuje pravý panel, 

ve kterém je možno přeložit název, popis a vysvětlení daného atributu. Pokud dojde 

k přeložení všech tří částí, objeví se v levém panelu vedle atributu malá ikona EU. 

Po dokončení překladu atributů je třeba Translation Project uložit. 
 

 
 

Obr. 4.5: Překládací okno TaxDes Translation 
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 V editovacím okně nástroje TaxDes Translation s otevřeným vydáním vytvořeného 

Taxonomy Project souboru je nyní možné importovat překlad taxonomie pomocí 

funkce Translation > Import Translation Project, viz obrázek 4.4. Překlad by se měl 

po chvíli zobrazit, pokud ne, stačí zavřít okno vydání a znovu jej otevřít. Zbývá pouze 

generovat nový soubor taxonomie prostřednictvím funkce Generate > Make 

Dictionary, vybrat jazyk, název souboru a jeho umístění a potvrdit. Vytvořený soubor 

má příponu .dict. 

 

 
 

Obr. 4.6: Generování nového souboru taxonomie funkcí Make Dictionary 

 

Section Designer 

Nová sekce se v nástroji Section Designer vytváří pomocí funkce File > New Section, 

která otevře nové okno určené ke specifikaci této sekce. Povinná pole jsou Section 

name (Název sekce), Release (Vydání), Taxonomy (Taxonomie) a Based on Entity 

(Založeno na entitě), ostatní pole jsou nepovinná. Název sekce je libovolný, číslo 

vydání je předvoleno na 1.0.0.0 a není nutné jej měnit. Jako soubor taxonomie je 

třeba vybrat soubor generovaný z TaxDes Translation s přeloženou taxonomií 

s příponou .dict. Nejjednodušší je založit sekci na Root Entity (Kořenová entita), 

protože umožňuje přístup ke všem subentitám a atributům v celé taxonomii. 

 

 Po potvrzení úvodního okna se vytvoří nová sekce. Prostřednictvím funkce View > 

Options lze upravit základní podobu sekce – počet řádků a sloupců (obr. 4.7 A), 

rozměry buněk tabulky (obr. 4.7 B), rozměry prvků vkládaných do buněk, jejich 

odsazení a zarovnání (obr. 4.7 C) a písmo (obr. 4.7 D). 

 



 

 

NÁVRH VYUŽITÍ NÁSTROJE ECCAIRS 5 TAXONOMY DESIGN TOOLS 

46 

 
Obr. 4.7: Okno funkce View > Options 

 

 Do tabulky sekce je možné vkládat všechny druhy prvků obsažené vlevo 

v Toolbox panelu. Konkrétní prvky podle vybraného druhu jsou pak zobrazeny 

ve stejném panelu dole. Například pokud je jako druh prvku zvoleno Atribute 

Definition + Value (Popis atributu + hodnota), v dolní části Toolbox panelu se zobrazí 

všechny dostupné atributy obsažené v kořenové entitě (viz obrázek 4.8 A) 

a přetažením vybraného atributu do tabulky sekce se ve zvolené buňce objeví prvek 

s popisem atributu a v sousední buňce vpravo se objeví prvek s hodnotou tohoto 

atributu. 

 

 Pro vložení atributů obsažených v subentitách kořenové entity do tabulky sekce je 

nutné aplikovat následující postup. Napřed je třeba vybrat jako typ prvku Entity panel 
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(Panel entity) a v dolní části Toolbox panelu pak zvolit, kolik bude panel této 

subentity zabírat řádků a sloupců v tabulce sekce, vybrat požadovanou subentitu 

a jejím přetažením vložit panel do tabulky sekce (obr. 4.8 B). Při označeném panelu 

subentity (má světle zelenou barvu, neoznačený je tyrkysový) a zvolením Attribute 

Definition + Value jako typu prvku se níže v Toolbox panelu zobrazí atributy 

obsažené v subentitě, jejíž panel je právě označen v tabulce (viz obrázek 4.9). 

Tyto atributy je možné následně přenést do tabulky sekce, ale pouze do oblasti 

panelu subentity. Pokud subentita kromě atributů obsahuje ještě další vnořené 

subentity, lze panely těchto subentit vkládat pouze do panelu jejich nadřazené 

subentity. Atribut kořenové entity nebo subentity je vždy možné vložit do jejího 

vlastního panelu nebo do panelu její vnořené subentity. 

 

 Do sekce lze vložit i obrázek nebo vlastní text. Obrázek je nutné vybrat ze složky 

počítače, v Toolbox panelu se zobrazí i náhled obrázku (obr. 4.8 C). Text se vepisuje 

do připraveného pole (obr. 4.8 D). V obou případech pak lze daný prvek přenést 

do tabulky sekce pomocí tlačítka Drag&Drop (Táhni a pusť). 

 

 
Obr. 4.8 Toolbox panel 
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Obr. 4.9: Atribute Definition + Value při označeném Entity panelu v tabulce sekce 

 

 Všechny prvky v sekci (atributy, hodnoty atributů, panely entit atd.) jsou 

editovatelné v Properties panelu vpravo. Panel umožňuje měnit název prvku, 

umístění a rozměr prvku v tabulce sekce, odsazení, font, viditelnost ohraničení i text. 

Náhled sekce je pak zobrazen pomocí funkce File > Section Preview, kde je možné 

na vyzkoušení vyplnit pole hodnot atributů nebo změnit barvy sekce. Hotová sekce je 

uložena s příponou .esd. 

 

View Designer 

Vytvořené sekce je nyní potřeba uspořádat do náhledu. Nový náhled (New View) 

se vytváří stejně jako nová sekce, okno ke specifikaci náhledu má stejná povinná 

i nepovinná pole a postup je analogický. Sekce se do View Designeru vkládají 

prostřednictvím funkce Tools > Section Reference, kde se tlačítkem + otevře nové 

okno, ve kterém je možné vybrat ze složky počítače požadované sekce. 

 Je možné je vložit přímo do výchozího kořenového tématu Occurrence (Událost), 

poté bude náhled v ECCAIRS Browseru tvořit pouze samotný sled sekcí bez Topic-

tree panelu vlevo. Pokud je třeba mít v náhledu více témat, použije se funkce Edit > 

Add Child Topic, která vytvoří nové téma jako podúroveň tématu, které je označené 

při vytváření, viz obrázek 4.10. 
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Obr. 4.10: Funkce Add Child Topic 

 

 Do každého tématu je možno vložit vybrané sekce. K tomu slouží funkce Edit > 

Manage Sections, kde pomocí šipek přesuneme potřebné sekce z levého okna 

do pravého. Témata lze upravit v Properties panelu vpravo (název, ikona, font, pořadí 

sekcí, apod.). Náhled s alespoň jedním nově vytvořeným tématem je v ECCAIRS 

Browseru zobrazen včetně Topic-tree panelu. 

 Náhled je možné si zobrazit pomocí File > Preview, kde je možné vybírat různá 

témata a zobrazovat si tak sekce, které jsou v nich vložené, dále na vyzkoušení 

vyplnit pole hodnot atributů i měnit barvy celého náhledu. Náhled se ukládá 

s příponou .evd. 

 

Repository Manager 

Aby bylo možné si nově vytvořený náhled zobrazit v ECCAIRS Browseru, je potřeba 

jej vložit do Repository Manageru. 

 V sekci Taxonomy v části Taxonomy je nutné vyměnit soubor taxonomie 

za soubor .dict generovaný z TaxDes Translation s přeloženou taxonomií, 

viz obrázek 4.11.  
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Obr. 4.11: Okno Repository Manageru pro vložení souboru taxonomie 

 

 V sekci Profiles > View  je pak třeba přidat pomocí funkce pravé tlačítko myši > 

Add View Profile from File vytvořený náhled ze složky počítače, viz obrázek 4.12.  
 

 
 

Obr. 4.12: Přidání nového náhledu FORMULÁŘ funkcí Add View Profile from File 
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 Nakonec v sekci Roles je ještě potřeba přidat pomocí šipek tento náhled z levého 

okna (Available profiles) do pravého (Assigned profiles), viz obrázek 4.13. Změny je 

třeba uložit prostřednictvím funkce Repository > Save changes nebo v Toolbaru 

tlačítkem Update. 
 

 
 

Obr. 4.13: Přidání nového náhledu do role 

 

 Při otevření ECCAIRS Browseru je nyní dostupný nový náhled, viz obrázek 4.14. 

Tento náhled má podobu formuláře pro hlášení události ÚZPLN a obsahuje tedy 

všechny informace, které se do tohoto formuláře vyplňují. Je rozdělen do dvou témat 

– Formulář povinného hlášení a Formulář dobrovolného hlášení – a v plném rozsahu 

je uveden v příloze 7. 
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Obr. 4.14: ECCAIRS Browser s nově vytvořeným náhledem FORMULÁŘ 
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ZÁVĚR 
 

Cílem této diplomové práce bylo popsat možnosti modifikací systému ECCAIRS 

a také navrhnout možné modifikace pro zefektivnění práce s tímto databázovým 

systémem s využitím definovaného vývojového prostředí (Taxonomy Design Tools) 

dle uživatelských potřeb na národní úrovni. 

 

 Práce je nejdříve věnována samotnému hlášení leteckých nehod a incidentů podle 

Nařízení Evropského parlamentu a Komise (EU) č. 376/2014, s bližším zaměřením 

na postup hlášení událostí v České republice, a dále je popisován systém ECCAIRS 

sloužící jako databázový systém hlášení nehod a incidentů v letectví i jiných 

oblastech dopravy, pro uchování informací, jejich sdílení, analýzu a vyhodnocování. 

Jsou zde rozebrány nejdůležitější nástroje systému ECCAIRS a jejich funkce. 

 

 Systém ECCAIRS lze modifikovat pomocí sady nástrojů Taxonomy Design Tools, 

která obsahuje celkem pět nástrojů určených k úpravě a překladu taxonomie, a sady 

User Interface Design, která sestává ze dvou nástrojů umožňujících změny designu 

uživatelského prostředí. Všechny tyto nástroje jsou v práci podrobně popsány. 

 

 Hlášení událostí uložená v databázi si lze prohlédnout pomocí nástroje ECCAIRS 

Browser (Prohlížeč), který má vestavěné náhledy pro zobrazení informací uložených 

v hlášení. Žádný tento náhled ale není schopen zobrazit všechny potřebné informace 

na jedné stránce, proto jsem pro zefektivnění práce se systémem ECCAIRS vytvořila 

nový náhled pro ECCAIRS Browser, který má podobu hlášení leteckých událostí 

Úřadu pro odborné zjišťování příčin leteckých nehod (ÚZPLN). Mimo vytvoření 

samotného náhledu bylo potřeba i přeložit část taxonomie, využila jsem tedy obou 

dostupných sad pro modifikaci systému ECCAIRS.  

 

 Výsledkem praktické části této práce je podrobný popis postupu překladu 

taxonomie a vytvoření nového náhledu pro ECCAIRS Browser, který usnadní práci 

s informacemi v databázi na národní úrovni jak při zadávání nových hlášení, tak při 

kontrole správnosti a prohlížení dat. Soubory přeložené taxonomie a náhledu 

pro ECCAIRS Browser tvoří elektronickou přílohu práce. 
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SEZNAM POUŽITÝCH ZKRATEK A SYMBOLŮ 

 

ADREP  The Accident/Incident Data Reporting 
   Hlášení dat o nehodách/incidentech 
 
CAA  Civil Aviation Authority 
   Úřad pro civilní letectví 
 
EASA  European Aviation Safety Agency 

  Evropská agentura pro bezpečnost v letectví 
 
ECCAIRS  European Co-ordination Centre for Aviation Incident 

Reporting System 
Evropské koordinační centrum systému hlášení leteckých 

   incidentů 
 
ECR-ECCAIRS The European Central Repositories for occurences 

Evropský centrální archiv událostí 
 
ECR-SRIS  The European Central Repositories for safety 

Recommendations 
Evropský centrální archiv pro bezpečnostní doporučení 

 
ICAO  International Civil Aviation Organisation 
   Mezinárodní organizace pro civilní letectví 
 
JRC  Joint Research Centre of the European Commission 

Sdružené výzkumné centrum Evropské komise 
 
PDF  Portable Document Format 
   Přenosný formát dokumentů 
 
SIA  Safety Investigation Authorities 
   Úřad pro vyšetřování leteckých nehod 
 
TaxDes  Taxonomy Designer 
   nástroj pro úpravu taxonomie 
 
ÚZPLN  Ústav pro odborné zjišťování příčin leteckých nehod 
 
XLS  Excel Spreadsheet 
   Sešit aplikace Excel 
 
WebDAS  Web Data Access System 
   Webová aplikace pro přístup k datům 
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Příloha 1:  Klasifikace událostí v civilním letectví podle Prováděcího nařízení 
Komise (EU) 2015/1018 

 
Příloha I – Události související s provozem letadla 

1) Letecký provoz 

a. Letová příprava 

b. Příprava letadla 

c. Vzlet a přistání 

d. Kterákoli fáze letu 

e. Jiné typy událostí 

2) Technické události 

a. Konstrukce a systémy 

b. Pohonné jednotky (včetně motorů, vrtulí a rotorů) a pomocné 

energetické jednotky (APU, Auxiliary Power Unit) 

3) Interakce s letovými navigačními službami a s uspořádáním letového provozu 

4) Nouzové stavy a jiné kritické situace 

5) Vnější prostředí a meteorologie 

6) Bezpečnost 

 

Příloha II – Události související s technickými podmínkami, údržbou a opravou 

letadla 

1) Výroba 

2) Konstrukce 

3) Údržba a řízení zachování letové způsobilosti 

 

Příloha III – Události týkající se navigačních letových služeb a zařízení 

1) Události týkající se letadel 

2) Zhoršení nebo úplný výpadek služeb nebo funkcí 

3) Jiné události 

 

Příloha IV – Události související s letišti a pozemními službami 

1) Řízení bezpečnosti letiště 

a. Události související s letadly a překážkami 

b. Zhoršení nebo úplný výpadek služeb nebo funkcí 

c. Jiné události 

2) Pozemní odbavování letadla 

a. Události související s letadly a letištěm 

b. Zhoršení nebo úplný výpadek služeb nebo funkcí 

c. Zvláštní události související s pozemním odbavováním 

 

 

 



 

 

Příloha V – Události týkající se letadel jiných než složitých motorových letadel, 

včetně kluzáků a vzdušných dopravních prostředků lehčích než vzduch 

1) Letadlo jiné než složité motorové letadlo s výjimkou kluzáků a vzdušných 

dopravních prostředků lehčích než vzduch 

a. Letový provoz 

b. Technické události 

c. Interakce s letovými navigačními službami a s uspořádáním letového 

provozu 

d. Nouzové stavy a jiné kritické situace 

e. Vnější prostředí a meteorologie 

2) Kluzáky 

a. Letový provoz 

b. Technické události 

c. Interakce s letovými navigačními službami a s řízením letového provozu 

d. Nouzové stavy a jiné kritické situace 

e. Vnější prostředí a meteorologie 

3) Vzdušné dopravní prostředky lehčí než vzduch (balony a vzducholodě) 

a. Letový provoz 

b. Technické události 

c. Interakce s letovými navigačními službami a s uspořádáním letového 

provozu 

d. Nouzové stavy a jiné kritické situace 

e. Vnější prostředí a meteorologie [9] 

 
  



 

 

Příloha 2: Základní informace uváděné v hlášení letecké události podle 
Nařízení Evropského parlamentu a Rady (EU) č. 376/2014 

 
 
SPOLEČNÁ POVINNÁ DATOVÁ POLE: 

 

1) Nadpis 

 Nadpis 

2) Informace o složce 

 Odpovědný subjekt 

 Číslo složky 

 Status události 

3) Kdy 

 Datum v UTC (Coordinated Universal Time, koordinovaný světový čas) 

4) Kde 

 Stát/oblast události 

 Místo události 

5) Zařazení 

 Třída události 

 Kategorie události 

6) Popis 

 Jazyk popisu 

 Popis 

7) Události 

 Typ události 

8) Klasifikace rizika 

 

SPECIFICKÁ POVINNÁ DATOVÁ POLE: 

 

A) Datová pole týkající se letadla 

1) Identifikace letadla 

 Stát zápisu letadla do rejstříku 

 Výrobce/typ/série 

 Výrobní číslo letadla 

 Poznávací značka letadla 

 Volací značka 

2) Provoz letadla 

 Provozovatel 

 Druh provozu 

  



 

 

3) Popis letadla 

 Kategorie letadla 

 Typ pohonu 

 Hmotnostní skupina 

4) Historie letu 

 Poslední místo odletu 

 Plánované místo určení 

 Fáze letu 

5) Počasí 

 Vliv počasí 

 

B) Datová pole týkající se letových navigačních služeb 

1) Vztah k uspořádání letového provozu 

 Vliv uspořádání letového provozu 

 Ovlivněná služba (dopad na službu uspořádání letového 

provozu) 

2) Označení jednotky letové provozní služby 

Datová pole týkající se nedodržení minimálního odstupu / ztráty rozestupu a 

narušení letového prostoru 

1) Vzdušný prostor 

 Druh vzdušného prostoru 

 Třída vzdušného prostoru 

 Označení letové informační oblasti (FIR, Flight Information 

Region) / vyšší informací oblasti (UIR, Upper Information 

Region) 

 

C) Datová pole týkající se letiště 

1) Směrovací značka místa (značka letiště) 

2) Místo letiště 

 

D) Datová pole týkající se poškození letadla či zranění osoby 

1) Závažnost 

 Nejvyšší škoda 

 Míra zranění 

2) Zranění osob 

 Počet zranění na zemi (smrtelná, těžká, lehká) 

 Počet zranění v letadle (smrtelná, těžká, lehká) [8] 

 
  



 

 

Příloha 3: Žádost o informace z ECCAIRS Repository dostupná na portálu 
ÚZPLN 

 
 

 
 

Obr. 1: Žádost o informace z ECCAIRS Repository 
 

  



 

 

Příloha 4: Časová posloupnost hlášení letecké události v ČR 
 
Při vzniku letecké nehody nebo incidentu je nutné, aby byla příslušnou osobou 

nahlášena do 72 hodin. Osoba může událost nahlásit nejdříve své organizaci, a to do 

72 hodin, tato organizace poté musí do 72 hodin po obdržení hlášení nahlásit danou 

událost odpovědnému vnitrostátnímu orgánu (v ČR tedy ÚZPLN), nebo může osoba 

nahlásit událost přímo ÚZPLN do 72 hodin. Od přijetí hlášení o události má 

organizace dále 1 měsíc na doplňující hlášení na ÚZPLN a 3 měsíce na podání 

závěrečné zprávy o události. ÚZPLN mezitím uloží hlášení do národní databáze 

leteckých nehod a odešle hlášení do Evropské centrální databáze. Po obdržení 

závěrečné zprávy má lhůtu 2 měsíců na odeslání této zprávy do Evropské centrální 

databáze, viz obr. 2. [10] 

 

 
Obr. 2:  Časová posloupnost hlášení leteckých nehod a incidentů v ČR [10] 

 
  



 

 

Příloha 5: Formuláře povinného a dobrovolného hlášení ÚZPLN 

 

Formulář povinného hlášení ÚZPLN: 

 

 
 

 



 

 

 
 

 
 



 

 

 
 

 
 



 

 

 
 

 
 

Obr. 3: Formulář povinného hlášení ÚZPLN 

  



 

 

Formulář dobrovolného hlášení ÚZPLN: 

 

 
 

 
 

Obr. 4: Formulář dobrovolného hlášení ÚZPLN  



 

 

Příloha 6:  Blokové schéma postupu překladu taxonomie a vytváření nového 

   náhledu pro ECCAIRS Browser 

 

 
Obr. 5: Blokové schéma postupu 



 

 

Příloha 7: Výsledná podoba vytvořeného náhledu pro ECCAIRS Browser 

  v podobě formuláře hlášení události ÚZPLN 

 

Formulář hlášení – povinný: 

 
 

 



 

 

 
 

 



 

 

 
 

 
 

Obr. 6: Formulář hlášení - povinný 

 

 



 

 

Formulář hlášení – dobrovolný: 

 
 

 
 

Obr. 7: Formulář hlášení - dobrovolný 


